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Introduction

This example shows how to use an Optimization study to update the optical prescription 
for a multi-element objective lens when one of the glasses is replaced. Because of slight 
differences in the refractive index and Abbe number of the replacement glass compared to 
the original glass, some small adjustments to the geometry sequence are required to ensure 
that the lens still produces a high-quality image.

For an introduction to ray optics simulation of a Petzval Lens (without the Optimization 
study), see the tutorial model Ray_Optics_Module/Lenses_Cameras_and_Telescopes/
petzval_lens.

Model Definition

The Petzval lens setup used in this example includes two cemented doublets and a field 
flattener. Each of the two cemented doublets typically consists of a crown glass (low 
refractive index, less dispersion) on the side the object, and a flint glass (higher index, 
greater dispersion) on the side facing the image plane.

Figure 1: Overview of the Petzval lens. The lens includes a field-flattening element. In this 
view the marginal rays of an on-axis trace are shown, together with the chief ray of 5 
additional fields.
2 |  P E T Z V A L  L E N S  O P T I M I Z A T I O N



D I S P E R S I O N  I N  O P T I C A L  G L A S S

The refractive index of an optical glass always depends on the wavelength of the light 
passing through it. A common way to compare the optical properties of different glasses 
is by comparing their values of the d-line refractive index nd and Abbe number Vd,

where

• The d-line is a yellow helium spectral line at about 587.56 nm,

• The F-line is a blue hydrogen spectral line at about 486.13 nm, and

• The C-line is a red hydrogen spectral line at about 656.28 nm.

Keeping the d-line refractive index constant, a lower Abbe number means that the 
refractive index of the glass is more sensitive to changes in the refractive index (greater 
dispersion), while a higher Abbe number means lower sensitivity (less dispersion).

Historically, optical glasses have been roughly categorized as crown glasses and flint 
glasses. On average, the crown glasses have lower index and higher Abbe number, while 
flint glasses have higher index and lower Abbe number. A scatter plot of refractive index 
versus Abbe number for comparing different glasses is called an Abbe diagram.

A common way to report the Abbe number and d-line refractive index of a glass is through 
a six-digit glass code. In the glass code, the first three digits are the digits of the refractive 
index (after the decimal point) and the last three digits are the Abbe number (multiplied 
by 10). For example, a glass with code 654321 has a d-line refractive index of 1.654 and 
an Abbe number of 32.1.

C H O O S I N G  A  R E P L A C E M E N T  G L A S S

There are many legitimate reasons why an optical designer might want to replace the glass 
in a lens system:

• The new glass might be less expensive, more readily available, or be easier to work with.

• The new glass might have other desirable material properties, such as a lower coefficient 
of thermal expansion, lower density, or superior scratch resistance.

• The new glass might be produced in a more environmentally friendly way.

• The old glass might contain additives such as lead, cadmium, or arsenic that can be 
hazardous to human health.

Vd
nd 1–

nF nC–
--------------------=
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Regardless of the reason for the change, the integration of optimization tools into optical 
ray tracing software can be used to modify an existing optical prescription to use a 
replacement glass with similar (but not exactly the same) optical properties.

In this example, the geometry sequence is based on the optical prescription shown in 
Table 1, which in turn was inspired by a prescription from Ref. 1, p. 191. The focal length 
is 100.0 mm and the focal ratio is approximately f/2.4. The instructions for creating the 
lens geometry can be found in the Appendix — Geometry Instructions.

In 2018 the glass in the second element, S-BAH32 glass from the Ohara corporation, was 
changed to a “special order” glass (Ref. 2), with a notice that “Special order types may be 
still available for some time, but we do not guarantee, on your order we can melt these 
types”. Thereafter, potential replacement glasses for S-BAH32 were considered. The six-
digit glass code of the S-BAH32 glass is 670393, meaning it has a d-line refractive index 
of 1.670 and an Abbe number of 39.3. Two potential replacement glasses were identified:

• Schott N-BASF64, glass code 704394 (nd = 1.704, Vd = 39.4)

• Schott N-KZFS5, glass code 654397 (nd = 1.654, Vd = 39.7)

Ultimately the Schott N-KZFS5 glass was chosen. This glass has nearly the same Abbe 
number as the Ohara S-BAH32 glass but a slightly lower d-line refractive index. Therefore, 
if the glass is simply replaced without any updates to the geometry sequence, the 
resolution of the lens system will be significantly diminished. Figure 4 and Figure 5 show 
the ray and spot diagrams when using the unmodified prescription from Table 1.

TABLE 1:  PETZVAL LENS PARAMETERS.

Index Name Radius 
(mm)

Thickness 
(mm)

Material Clear radius 
(mm)

— Object ∞ ∞ — —

1 Lens 1 99.56266 13.00000 N-BK7 28.478

2 Lens 2 -86.84002 4.00000 S-BAH32 26.276

— — -1187.63858 40.00000 — 22.020

3 Stop ∞ 40.00000 — 16.631

4 Lens 3 57.47191 12.00000 N-SK2 20.543

5 Lens 4 -54.61865 3.00000 N-SF5 20.074

— — -614.68633 46.82210 — 16.492

6 Lens 5 -38.17110 2.00000 N-SF5 17.297

— — ∞ 1.9548 — 18.940

— Image ∞ — — 17.904
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S E T T I N G  U P  T H E  O P T I M I Z A T I O N  S T U D Y

To improve the image quality when using the replacement glass, an Optimization study was 
performed. The control parameters for this study were perturbations in the lens radii of 
curvature. Since the model geometry includes two cemented double lenses and a field 
flattener with one curved surface, a total of seven control parameters were used. The 
objective function is the sum of the squares of the root mean square (rms) spot sizes for 
three different field angles (on-axis, 6°, and 9°). In addition, rays of three different vacuum 
wavelengths were released (475 nm, 550 nm, and 625 nm).

Although the Optimization study supports both gradient-based and gradient-free 
optimization methods, only the gradient-free methods are appropriate to use with ray 
optics simulation, because the degrees of freedom solved for are discrete ray coordinates 
and directions rather than the values of a continuous field variable. The BOBYQA 
optimization method was used because it is well-suited to optimization problems with a 
fairly large number of control parameters but no constraints.

The original model geometry was constructed by repeated insertion of part instances from 
the COMSOL Part Libraries, mainly the “Spherical Lens 3D” part. Since these parts are 
parameterized representations of the lens surfaces, it was convenient to add perturbations 
the radii of curvature of each curved refracting surface.

Results and Discussion

The Petzval lens geometry sequence is shown in Figure 2 and the mesh can be seen in 
Figure 3.

A ray tracing analysis of the original geometry yields the ray diagram shown in Figure 4 
and the spot diagram (in the nominal image plane) shown in Figure 5. The rms spot size 
is on the order of several hundred micrometers for all three field angles.

After the Optimization study is run, the ray and spot diagrams of the resulting geometry 
are shown in Figure 6 and Figure 7. Compared to the previous solution, the rms spot sizes 
have been reduced by a factor of almost 100.

It is important to note that optimization methods generally seek a local minimum in the 
objective function by varying the control parameters, not a global minimum in the 
prescribed range of control parameter values. Therefore, different values of the radii of 
curvature in the optimized geometry may be found, especially if a different set of initial 
values is given. This may cause the spot diagram to look slightly different from Figure 7, 
although the spot sizes should be comparable in magnitude. Lens optimization is a rich 
design space, and the solution presented here is only one of many possible local minima.
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Figure 2: The Petzval lens geometry sequence.

Figure 3: The Petzval lens mesh.
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Figure 4: Ray diagram of the Petzval lens before optimization. A close-up look shows that the 
rays are not well focused at the nominal image plane.

Figure 5: Spot diagram of the Petzval lens in the nominal image plane before optimization.
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Figure 6: Ray diagram for the optimized Petzval lens. with replacement glass.

Figure 7: Spot diagram array for the optimized Petzval lens with replacement glass.
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Application Library path: Ray_Optics_Module/Lenses_Cameras_and_Telescopes/
petzval_lens_optimization

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Optics > Ray Optics > Geometrical Optics (gop).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces > Ray Tracing.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters 1: Lens Prescription
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Parameters 1: Lens Prescription in 
the Label text field. The lens prescription will be added when the geometry sequence is 
inserted in the following section.

Parameters 2: General
The Petzval Lens simulation parameters can be loaded from a text file.

1 In the Home toolbar, click Parameters and choose Add > Parameters.
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2 In the Settings window for Parameters, type Parameters 2: General in the Label text 
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_optimization_parameters.txt.

P E T Z V A L  L E N S

Insert the prepared geometry sequence from file. You can read the instructions for creating 
the geometry in the appendix. Following insertion, the lens definitions will be available in 
the Parameters 1: Lens Prescription node.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

4 In the Label text field, type Petzval Lens.

5 In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.

6 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_optimization_geom_sequence.mph.

7 In the Geometry toolbar, click Build All.

8 Click the Orthographic Projection button in the Graphics toolbar.

9 In the Graphics window toolbar, click next to Go to Default View, then choose 
Go to ZY View. This will orient the view to place the optical axis (z-axis) horizontal and 
the y-axis vertical. Compare the resulting geometry to Figure 2.

A D D  M A T E R I A L

1 In the Materials toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Optical > Schott Glass > Schott N-BK7 Glass.

4 Click the Add to Component button in the window toolbar.

5 In the tree, select Optical > Schott Glass > Schott N-KZFS5 Glass.

6 Click the Add to Component button in the window toolbar.

7 In the tree, select Optical > Schott Glass > Schott N-SK2 Glass.

8 Click the Add to Component button in the window toolbar.

9 In the tree, select Optical > Schott Glass > Schott N-SF5 Glass.

10 Click the Add to Component button in the window toolbar.
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11 In the Materials toolbar, click Add Material to close the Add Material window.

M A T E R I A L S

Schott N-BK7 Glass (mat1)
1 In the Settings window for Material, locate the Geometric Entity Selection section.

2 From the Selection list, choose Lens Material 1.

Schott N-KZFS5 Glass (mat2)
1 In the Model Builder window, click Schott N-KZFS5 Glass (mat2).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Lens Material 2.

Schott N-SK2 Glass (mat3)
1 In the Model Builder window, click Schott N-SK2 Glass (mat3).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Lens Material 3.

Schott N-SF5 Glass (mat4)
1 In the Model Builder window, click Schott N-SF5 Glass (mat4).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Lens Material 4.

G E O M E T R I C A L  O P T I C S  ( G O P )

1 In the Model Builder window, under Component 1 (comp1) click Geometrical Optics (gop).

2 In the Settings window for Geometrical Optics, locate the Ray Release and Propagation 
section.

3 From the Wavelength distribution of released rays list, choose Polychromatic,

specify vacuum wavelength. The list of polychromatic wavelengths will be entered 
below.

4 In the Maximum number of secondary rays text field, type 0. In this simulation stray light 
is not being traced, so reflected rays will not be produced at the lens surfaces.

5 Locate the Material Properties of Exterior and Unmeshed Domains section. From the 
Optical dispersion model list, choose Air, Edlen (1953). The lenses are assumed to be 
surrounded by air at room temperature.
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Medium Properties 1
1 In the Model Builder window, under Component 1 (comp1) > Geometrical Optics (gop) 

click Medium Properties 1.

2 In the Settings window for Medium Properties, locate the Medium Properties section.

3 From the Refractive index of domains list, choose Get dispersion model from material. 
Each of the materials added above contain the optical dispersion coefficients which can 
be used to compute the refractive index as a function of wavelength.

Material Discontinuity 1
1 In the Model Builder window, click Material Discontinuity 1.

2 In the Settings window for Material Discontinuity, locate the Rays to Release section.

3 From the Release reflected rays list, choose Never.

Release from Grid 1
Release the rays from a hexapolar grid, using quantities defined in the Parameters node.

1 In the Physics toolbar, click Global and choose Release from Grid.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 From the Grid type list, choose Hexapolar.

4 Specify the qc vector as

The Center location of the hexapolar grid will change according to the field angle.

5 Specify the rc vector as

The Cylinder axis direction is the same as the global optical axis.

6 In the Rc text field, type P_nom/2.

7 In the Nc text field, type N_ring.

dx1 x

dy1 y

dz z

nix x

niy y

niz z
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8 Locate the Ray Direction Vector section. Specify the L0 vector as

The Ray direction vector is calculated using the field angles defined in the Parameters 
node.

9 Locate the Vacuum Wavelength section. From the Distribution function list, choose 
List of values.

10 In the Values text field, type 475[nm] 550[nm] 625[nm].

Release from Grid 2
1 Right-click Release from Grid 1 and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 Specify the qc vector as

4 Locate the Ray Direction Vector section. Specify the L0 vector as

Release from Grid 3
1 Right-click Release from Grid 2 and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 Specify the qc vector as

4 Locate the Ray Direction Vector section. Specify the L0 vector as

vx1 x

vy1 y

vz z

dx2 x

dy2 y

vx2 x

vy2 y

dx3 x

dy3 y

vx3 x

vy3 y
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Obstructions
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Obstructions in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Obstructions.

4 Locate the Wall Condition section. From the Wall condition list, choose Disappear.

Stop
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Stop in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Aperture Stop.

4 Locate the Wall Condition section. From the Wall condition list, choose Disappear.

Image
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Image in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Image Plane.

M E S H  1

In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 
Build All. The mesh should looks like Figure 3.

S T U D Y  1

Step 1: Ray Tracing
1 In the Model Builder window, under Study 1 click Step 1: Ray Tracing.

2 In the Settings window for Ray Tracing, locate the Study Settings section.

3 From the Time-step specification list, choose Specify maximum path length.

4 From the Length unit list, choose mm.

5 In the Lengths text field, type 0 200. The maximum optical path length is sufficient for 
rays released at large field angles to reach the image plane.

6 In the Study toolbar, click Compute.

R E S U L T S

Ray Trajectories (gop)
The default plot is a ray diagram with a color expression based on time, which is 
proportional to optical path length.
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1 In the Settings window for 3D Plot Group, locate the Color Legend section.

2 Clear the Show legends checkbox.

3 Click the Show Grid button in the Graphics toolbar.

4 Click the Show Axis Orientation button in the Graphics toolbar.

Compare this image to Figure 4. The rays appear to converge some distance away from 
the nominal image plane.

Spot Diagram
In the following steps, a spot diagram is created, and a custom color expression is added.

1 In the Results toolbar, click 2D Plot Group.

2 In the Settings window for 2D Plot Group, type Spot Diagram in the Label text field.

3 Locate the Color Legend section. Select the Show units checkbox.

Spot Diagram 1
In the Spot Diagram toolbar, click More Plots and choose Spot Diagram.

Color Expression 1
1 In the Spot Diagram toolbar, click Color Expression.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type gop.lambda0.

4 From the Unit list, choose nm.

5 Click to expand the Range section. Select the Manual color range checkbox.

6 In the Minimum text field, type 450.

7 In the Maximum text field, type 650.

8 In the Spot Diagram toolbar, click Plot.

9 Click the Zoom Extents button in the Graphics toolbar. Compare the resulting 
image to Figure 5.

G L O B A L  D E F I N I T I O N S

Parameters 3: Optimization
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 3: Optimization in the 
Label text field.

3 Locate the Parameters section. Click Load from File.
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4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_optimization_opt_parameters.txt.

Parameters 1: Lens Prescription
1 In the Model Builder window, click Parameters 1: Lens Prescription.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select 
Preset Studies for Selected Physics Interfaces > Ray Tracing.

4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Ray Tracing
1 In the Settings window for Ray Tracing, locate the Study Settings section.

2 From the Time-step specification list, choose Specify maximum path length.

3 In the Lengths text field, type 0 200.

4 From the Length unit list, choose mm.

Name Expression Value Description

R1_1 99.56266[mm]+dR1_1 0.099563 m L1, surface 1 radius 
of curvature

R2_1 -86.84002[mm]+dR2_1 -0.08684 m L1, surface 2 radius 
of curvature

R2_2 -1187.63858[mm]+dR2_2 -1.1876 m L2, surface 2 radius 
of curvature

R1_4 57.47191[mm]+dR1_4 0.057472 m L3, surface 1 radius 
of curvature

R2_4 -54.61865[mm]+dR2_4 -0.054619 m L3, surface 2 radius 
of curvature

R2_5 -614.68633[mm]+dR2_5 -0.61469 m L4, surface 2 radius 
of curvature

R1_6 -38.17110[mm]+dR1_6 -0.038171 m L5, surface 1 radius 
of curvature
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Parameter Optimization
1 In the Study toolbar, click Optimization and choose Parameter Optimization.

2 In the Settings window for Parameter Optimization, locate the Optimization Solver 
section.

3 From the Method list, choose BOBYQA.

4 In the Optimality tolerance text field, type 0.02.

5 Locate the Objective Function section. In the table, enter the following settings:

6 Locate the Control Parameters section. Click Load from File.

7 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_optimization_study_settings.txt.

Solution 2 (sol2)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 2 (sol2) node, then click Time-

Dependent Solver 1.

3 In the Settings window for Time-Dependent Solver, click to expand the Time Stepping 
section.

4 From the Steps taken by solver list, choose Manual.

5 In the Time step text field, type 200[mm]/c_const.

6 In the Study toolbar, click Compute.

R E S U L T S

Ray Trajectories (gop) 1
1 In the Settings window for 3D Plot Group, locate the Color Legend section.

2 Clear the Show legends checkbox.

3 In the Ray Trajectories (gop) 1 toolbar, click Plot.

Compare this image to Figure 6. The rays appear to converge some distance away from 
the nominal image plane.

Expression Description Evaluate for

comp1.gop.relg1.rrms^2 Ray Tracing

comp1.gop.relg2.rrms^2 Ray Tracing

comp1.gop.relg3.rrms^2 Ray Tracing
17 |  P E T Z V A L  L E N S  O P T I M I Z A T I O N



Spot Diagram 1
1 In the Model Builder window, right-click Spot Diagram and choose Duplicate.

2 In the Settings window for 2D Plot Group, locate the Data section.

3 From the Dataset list, choose Ray 2.

4 In the Spot Diagram 1 toolbar, click Plot.

Compare this image to Figure 7.

5 Click the Zoom Extents button in the Graphics toolbar.

Appendix — Geometry Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 Click Done.

G L O B A L  D E F I N I T I O N S

The detailed parameters of the lens can be imported from a text file. The prescription for 
the Petzval lens with a field flattener can be found in Ref. 1, pg 192.

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_optimization_geom_sequence_parameters.txt.

Petzval Lens Parameters
The parameters that define the Petzval lens geometric sequence are found in 
petzval_lens_optimization_geom_sequence_parameters.txt. These will be 
described in the tables below.
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1 First, define the global optical axis. This is used to orient the first lens only. The 
orientation of each subsequent lens will be relative to the preceding one.

2 Next, define the parameters for each of the lens elements. Each lens requires 8 
parameters in addition to the ray incident directions (which are set using the global 
values).

3 Finally, define the remaining lens parameters.

P E T Z V A L  L E N S  G E O M E T R Y  S E Q U E N C E

Start constructing the lens geometry.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, type Petzval Lens Geometry Sequence in the 
Label text field.

3 Locate the Units section. From the Length unit list, choose mm.

Parameter Description

nix Global optical axis, x-component

niy Global optical axis, y-component

niz Global optical axis, z-component

Parameter Description

R1_[n] Radius of curvature, surface 1, lens [n]

R2_[n] Radius of curvature, surface 2, lens [n]

Tc_[n] Center thickness, lens [n]

d0_[n] Outer diameter, lens [n]

d1_[n] Diameter, surface 1, lens [n]

d2_[n] Diameter, surface 2, lens [n]

d1_clear_[n] Clear aperture diameter, surface 1, lens [n]

d2_clear_[n] Clear aperture diameter, surface 2, lens [n]

Parameter Description

T_[n] Distance between lenses [n] and [n+1].

d0_S Stop maximum (outer) diameter

d1_S Stop minimum (clear) diameter

d0_D Diameter of image plane
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Insert the first of the Petzval Lens elements.

P A R T  L I B R A R I E S

1 In the Geometry toolbar, click Part Libraries.

2 In the Part Libraries window, select Ray Optics Module > 3D > Spherical Lenses > 
spherical_lens_3d in the tree.

3 Click Add to Geometry.

4 In the Select Part Variant dialog, select Specify clear aperture diameter in the 
Select part variant list.

5 Click OK. This part is used for each of the 5 Petzval Lens elements.

P E T Z V A L  L E N S  G E O M E T R Y  S E Q U E N C E

Lens 1
1 In the Model Builder window, under Component 1 (comp1) > 

Petzval Lens Geometry Sequence click Spherical Lens 3D 1 (pi1).

2 In the Settings window for Part Instance, type Lens 1 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_optimization_geom_sequence_lens1.txt. The files 
petzval_lens_optimization_geom_sequence_lensm.txt, where m=1,...,5, 
contain references to each of the individual lens parameters. This avoids having to enter 
the values manually. Note that the z-axis is the optical axis throughout this geometry; 
that is, nix=niy=0, niz=1.

5 Click Build Selected.

6 Click the Orthographic Projection button in the Graphics toolbar.

7 In the Graphics window toolbar, click next to Go to Default View, then choose 
Go to ZY View. This will orient the view to place the optical axis (that is, the z-axis) 
horizontally and the y-axis vertically.

Create cumulative selections defining the materials, clear apertures, obstructions and 
image plane that can be used within the final ray trace.

Cumulative Selections
In the Geometry toolbar, click Selections and choose Cumulative Selections.

Lens Material 1
1 Right-click Cumulative Selections and choose Cumulative Selection.
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2 In the Settings window for Selection, type Lens Material 1 in the Label text field.

Lens Material 2
1 In the Model Builder window, right-click Cumulative Selections and choose 

Cumulative Selection.

2 In the Settings window for Selection, type Lens Material 2 in the Label text field. In 
the same manner, add selections for Lens Material 3, Lens Material 4, Lens 
Exteriors, Clear Apertures, Obstructions, Aperture Stop, and Image Plane.

Lens 1 (pi1)
Now, apply these selections.

1 In the Model Builder window, under Component 1 (comp1) > 
Petzval Lens Geometry Sequence click Lens 1 (pi1).

2 In the Settings window for Part Instance, click to expand the Domain Selections section.

3 In the table, enter the following settings:

4 Click to expand the Boundary Selections section. In the table, enter the following 
settings:

Lens 2
Continue constructing the lens. Add the second lens element.

1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 2 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

Name Keep Physics Contribute to

All √ Lens Material 1

Name Keep Physics Contribute to

Exterior √ Lens Exteriors

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_optimization_geom_sequence_lens2.txt.

Each lens element can be positioned in the geometry by referencing it to an existing 
work plane. For this example, use a work plane that is defined by the vertex on the exit 
surface of the prior lens element.

5 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 1 (pi1).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).

7 Find the Displacement subsection. In the zwi text field, type T_1. This is the distance 
along the optical axis between the exit surface of lens 1 and the entrance surface of lens 
2.

8 Locate the Domain Selections section. In the table, enter the following settings:

9 Locate the Boundary Selections section. In the table, enter the following settings:

P A R T  L I B R A R I E S

Next, insert the stop.

1 In the Geometry toolbar, click Part Libraries.

2 In the Part Libraries window, select Ray Optics Module > 3D > Apertures and Obstructions 
> circular_planar_annulus in the tree.

3 Click Add to Geometry. This part is also used to define the image plane and 
additional obstructions.

Name Keep Physics Contribute to

All √ Lens Material 2

Name Keep Physics Contribute to

Exterior √ Lens Exteriors

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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P E T Z V A L  L E N S  G E O M E T R Y  S E Q U E N C E

Stop
1 In the Model Builder window, under Component 1 (comp1) > 

Petzval Lens Geometry Sequence click Circular Planar Annulus 1 (pi3).

2 In the Settings window for Part Instance, type Stop in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 2 (pi2).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_2+Tc_3.

7 Locate the Boundary Selections section. In the table, enter the following settings:

Lens 3
The remaining lenses are similarly defined. Next, add the third lens element.

1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 3 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_optimization_geom_sequence_lens3.txt.

5 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Stop (pi3).

6 From the Work plane list, choose Surface (wp1).

Name Expression Value Description

d0 d0_S 58 mm Diameter, outer

d1 d1_S 33.262 mm Diameter, inner

nix 0 0 Local optical axis, x-component

niy 0 0 Local optical axis, y-component

niz 1 1 Local optical axis, z-component

Name Keep Physics Contribute to

All √ Aperture Stop
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7 Find the Displacement subsection. In the zwi text field, type T_3.

8 Locate the Domain Selections section. In the table, enter the following settings:

9 Locate the Boundary Selections section. In the table, enter the following settings:

Lens 4
Next, add the fourth lens element.

1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 4 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_optimization_geom_sequence_lens4.txt.

5 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 3 (pi4).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).

7 Find the Displacement subsection. In the zwi text field, type T_4.

8 Locate the Domain Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to

All √ Lens Material 3

Name Keep Physics Contribute to

Exterior √ Lens Exteriors

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions

Name Keep Physics Contribute to

All √ Lens Material 4
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9 Locate the Boundary Selections section. In the table, enter the following settings:

Lens 5
Now, add the fifth and last lens element. This element gives the Petzval a flat image plane.

1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 5 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
petzval_lens_optimization_geom_sequence_lens5.txt.

5 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 4 (pi5).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).

7 Find the Displacement subsection. In the zwi text field, type T_5.

8 Locate the Domain Selections section. In the table, enter the following settings:

9 Locate the Boundary Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to

Exterior √ Lens Exteriors

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions

Name Keep Physics Contribute to

All √ Lens Material 4

Name Keep Physics Contribute to

Exterior √ Lens Exteriors

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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P A R T  L I B R A R I E S

Define the square image plane.

1 In the Geometry toolbar, click Part Libraries.

2 In the Part Libraries window, select Ray Optics Module > 3D > Apertures and Obstructions 
> rectangular_planar_annulus in the tree.

3 Click Add to Geometry.

P E T Z V A L  L E N S  G E O M E T R Y  S E Q U E N C E

Image
1 In the Model Builder window, under Component 1 (comp1) > 

Petzval Lens Geometry Sequence click Rectangular Planar Annulus 1 (pi7).

2 In the Settings window for Part Instance, type Image in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 5 (pi6).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_6.

7 Locate the Boundary Selections section. In the table, enter the following settings:

Name Expression Value Description

w0 d0_D 35.808 mm Width, outer

h0 d0_D 35.808 mm Height, outer

w1 0 0 m Width, inner

h1 0 0 m Height, inner

nix 0 0 Local optical axis, x-component

niy 0 0 Local optical axis, y-component

niz 1 1 Local optical axis, z-component

nwx 1 1 Rectangle width direction, x-component

nwy 0 0 Rectangle width direction, y-component

nwz 0 0 Rectangle width direction, z-component

Name Keep Physics Contribute to

All √ Image Plane
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8 Click Build All Objects.

9 Click the Zoom Extents button in the Graphics toolbar.

Create a selection that includes all lenses. This can be used to define physics features.

All Lenses
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type All Lenses in the Label text field.

3 On the object pi1, select Domain 1 only.

4 On the object pi2, select Domain 1 only.

5 On the object pi4, select Domain 1 only.

6 On the object pi5, select Domain 1 only.

7 On the object pi6, select Domain 1 only.

Petzval Lens Apertures
The following commands are used to insert each of the lens apertures. The annulus clear 
aperture diameters are determined by the outer diameter of the current lens element. Each 
lens aperture is positioned at either the entrance or exit lens surface edges.

Group 1 Aperture
1 In the Geometry toolbar, click Part Instance and choose Circular Planar Annulus.

2 In the Settings window for Part Instance, type Group 1 Aperture in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 1 (pi1).

5 From the Work plane list, choose Surface 1 edge (wp3).

Name Expression Value Description

d0 1.25*d0_1 72.5 mm Diameter, outer

d1 d0_1 58 mm Diameter, inner

nix 0 0 Local optical axis, x-component

niy 0 0 Local optical axis, y-component

niz 1 1 Local optical axis, z-component
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6 Locate the Boundary Selections section. In the table, enter the following settings:

Group 2 Aperture
1 In the Geometry toolbar, click Part Instance and choose Circular Planar Annulus.

2 In the Settings window for Part Instance, type Group 2 Aperture in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 3 (pi4).

5 From the Work plane list, choose Surface 1 edge (wp3).

6 Locate the Boundary Selections section. In the table, enter the following settings:

Group 3 Aperture
1 In the Geometry toolbar, click Part Instance and choose Circular Planar Annulus.

2 In the Settings window for Part Instance, type Group 3 Aperture in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

Name Keep Physics Contribute to

All √ Obstructions

Name Expression Value Description

d0 1.25*d0_4 56.25 mm Diameter, outer

d1 d0_4 45 mm Diameter, inner

nix 0 0 Local optical axis, x-component

niy 0 0 Local optical axis, y-component

niz 1 1 Local optical axis, z-component

Name Keep Physics Contribute to

All √ Obstructions

Name Expression Value Description

d0 1.25*d0_6 53.125 mm Diameter, outer

d1 d0_6 42.5 mm Diameter, inner

nix 0 0 Local optical axis, x-component

niy 0 0 Local optical axis, y-component

niz 1 1 Local optical axis, z-component
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4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 5 (pi6).

5 From the Work plane list, choose Surface 1 edge (wp3).

6 Locate the Boundary Selections section. In the table, enter the following settings:

7 In the Geometry toolbar, click Build All. Compare the resulting image to Figure 2.

Name Keep Physics Contribute to

All √ Obstructions
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